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SUMMARY

Interorganelle contact sites regulate lipid metabolism, organelle dynamics and
positioning, as well as apoptosis and autophagy. Here, we present a proximity
ligation assay (PLA) protocol for measuring the association of two organelles in
fixed cells. We describe steps for primary cell culture, primary cell transfection,
and the assay itself. We then detail procedures for manual and image J-based
analysis of PLA foci. This protocol optimizes the use of assay products and im-
proves the identification of PLA foci labeling actual contact sites.
For complete details on the use and execution of this protocol, please refer to
Ilamathi et al. (2023).1

BEFORE YOU BEGIN

This protocol details a step-by-step procedure to measure interorganelle contact sites in any cell

type using a modified proximity ligation assay. While this procedure can be used with any cell

type, we usually use it with primary human fibroblasts, which are large and flat cells that are easy

to image by confocal microscopy. As these cells are however challenging to grow and transfect,

we also provide a protocol for their transfection using Neon transfection. We have also tested this

assay in mouse embryonic fibroblasts, Huh7 hepatocarcinoma, JEG-3 placenta, and A549 lung

adenocarcinoma cells.1,2

KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Calnexin 1:200 Millipore MABF2067

TOM20 1:250 Abcam ab186735; RRID:AB_2889972

IP3R1 1:200 Novus Biologicals NBP2-22458

VDAC1 1:200 Sigma-Aldrich MABN504; RRID:AB_2716304

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Mouse IgG isotype control
1:200

Invitrogen 08-6599

Fluorescent-tagged secondary antibody 1:500 Jackson ImmunoResearch 715-605-150; RRID:AB_2340862
(Anti-mouse 647), 711-165-152;
RRID:AB_2307443 (Anti-Rabbit cy3)

Chemicals, peptides, and recombinant proteins

Dulbecco’s modified Eagle’s medium Wisent 319-005-CL

Trypsin with EDTA Wisent 325-042-CL

Penicillin-Streptomycin Wisent SV30010

Fetal bovine serum Corning 35-077-CV

L-glutamine solution Wisent 609-065 EL

1X phosphate-buffered saline, sterile Wisent 311-425-CL

Paraformaldehyde Sigma-Aldrich P6148

Bovine serum albumin Sigma-Aldrich A7906

Triton X-100 Sigma-Aldrich 9002-93-1

Epredia Immu-Mount Fisher Scientific 9990412

DAPI (40,6-diamidino-2-phenylindole,
dihydrochloride)

Thermo Fisher Scientific D1306

Critical commercial assays

Duolink in situ green kit mouse/rabbit Sigma-Aldrich DUO92014

Duolink in situ PLA probe anti-rabbit PLUS Sigma-Aldrich DUO92002

Duolink in situ PLA probe anti-mouse MINUS Sigma-Aldrich DUO92004

Duolink in situ wash buffers, fluorescence Sigma-Aldrich DUO82049

Neon Transfection System 10 mL Kit Thermo Fisher Scientific MPK1025

Experimental models: cell lines

Primary human fibroblasts (controls and
DRP1 mutants)

Skin biopsies (Research Ethics Board of
the Children’s Hospital of Eastern
Ontario (DRP1 mutants))

N/A

Recombinant DNA

mCherry Addgene 54517

mCherry-tagged CLIMP63 Addgene 136293

Software and algorithms

ImageJ National Institutes of Health https://imagej.nih.gov/ij/

R www.r-project.org/ R4.0.5

RStudio http://www.rstudio.com/ Version 2023.03.0 + 386

Other

Fisherbrand Cover Glasses Fisher Scientific 1254580

Neon transfection system Thermo Fisher Scientific 10431915

Dry bath

Confocal microscope Leica Microsystems Leica SP8

ll
OPEN ACCESS Protocol
MATERIALS AND EQUIPMENT

� Primary cell culture media.
Reagent Final concentration Amount

Dulbecco’s Modified Eagle Medium (DMEM) supplemented with
4.5 g/L glucose, sodium pyruvate, L-glutamine, and phenol red

N/A 440 mL

200 mM L-Glutamine 6 mM 5 mL

Fetal bovine serum (FBS) 10% 50 mL

Penicillin and Streptomycin (10,000 U/mL) 100 U/mL 5 mL

Total N/A 500 mL

Storage conditions: 4�C, up to 4 weeks.
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� Trypsin with EDTA, cell culture grade.

Storage conditions: 4�C, up to 3 weeks.

� 4% Paraformaldehyde (PFA).

4 g of Paraformaldehyde is added to 70 mL of 1X PBS and mixed in the magnetic stirrer. The tem-

perature is then slowly increased to 65�C and left for stirring until the paraformaldehyde is dissolved

completely. The solution can then be cooled down to 25�C and the pH adjusted to 7.4–7.5 with 1 N

NaOH. The volume is then adjusted to 100 mL with PBS. PFA solution can be stored at 4�C for short-

term storage (1–2 months) and ‒20�C for long-term storage (1 year).

� Phosphate buffered saline (PBS), pH 7.4–7.5.
Chemicals Concentration Amount (g) for 1 L

NaCl 137 mM 8

KCl 2.7 mM 0.2

Na2HOP4 10 mM 1.44

KH2PO4 2 mM 0.24
Adjust the pH and make up the volume to 1 L with water. Autoclave the PBS and store at 25�C for up

to 2 years or until a white precipitate is observed at the bottom of the bottle.

� Neon transfection kit, including the Neon tube, Neon pipette tip, electrolytic buffer (E), and cell

suspension buffer (R and T).

Note:A homemade transfection buffer can be used as an alternative to the company-supplied

electrolyte and suspension buffers. This sucrose-based buffer3 (250 mM sucrose and 1 mM

MgCl2 in D-PBS. Filter-sterilize and store at 4�C) can be used as a replacement for both

buffers.

� Duolink Proximity ligation assay kit- It includes a blocking solution, antibody diluent, wash buffer A

and B, probe (+/-), ligation buffer and enzyme, amplification enzyme, and its buffer.

Note: A higher volume of probes can be purchased individually.

� DAPI- A stock solution (5 mg/mL) is prepared in water and stored at 4�C up to 6 months Cover the

tubes with aluminum foil to protect them from the light.

� Primary antibodies from different animal species that face the cytosolic side of the organelles of

interest.

� Fluorophore-coupled secondary antibodies.

� Permeabilization buffer (0.2% Triton X-100 in PBS). Store at 4�C for up to a month.

� Home-made blocking buffer (1% BSA and 0.1% Triton X-100 in PBS). Store at 4�C for up to a

month.

� Nuclease-free high-purity water or 0.22 micron filtered autoclaved MilliQ water.

� Mounting solution (Immu-Mount).
STEP-BY-STEP METHOD DETAILS

Preparation of primary cell culture media

Timing: 1 h
STAR Protocols 5, 102915, March 15, 2024 3
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1. Warm DMEM, L-glutamine, FBS, and Penicillin-Streptomycin mix to 37�C before culture medium

preparation.

2. To 500 mL of DMEM, add 6 mM Glutamine, 10% FBS, and 100 U/mL Penicillin and streptomycin.

3. The medium can be immediately used or stored at 4�C until further use.

CRITICAL: It is ideal to maintain separate consumables (e.g., pipette tips and Pasteur
pipette) and solutions (e.g., PBS) for primary cell culture. This avoids any cross-microbial

contamination and saves time to grow the primary cells. All the steps, including media

preparation, cell culture, and transfection, must be performed in a sterile environment.
Primary cell culture

Timing: 4–5 days

4. Rapidly hand-thaw frozen human primary fibroblasts and resuspend them in 10 mL of primary cell

culture medium.

5. Centrifuge the cells at 600 3 g for 5 min at 25�C.
6. Aspirate the medium and

a. add 1 mL of fresh medium to the cell pellet.

b. Once cells are resuspended, grow them in an appropriate cell culture plate.

CRITICAL: Primary fibroblast cells grow better when they have neighboring cells nearby,
that is, when cell density is relatively high in the culture plate. So, reviving the cells in 6-well

plates rather than a 100 mm dish is better when the cell pellet size is small (�10 mL).
7. Incubate the plate at 37�C with 5% CO2.

8. Once the cells reach 75%–80% confluency,

a. remove the medium,

b. wash once with PBS, detach cells with trypsin (300 mL for 6-well or 1 mL for 100 mm plate) for

5 min 37�C.
c. Pellet the cells at 600 3 g for 5 min at 25�C.

9. The cells can then be resuspended in DMEM and transferred to a new plate for further expansion,

or the pellet can be used for Neon transfection (below).
Transfection of primary cells

Timing: 1–2 days

Transfection of primary cells with a plasmid or siRNAs is challenging with transfection lipid reagents.

We have found that the Neon transfection system is much more efficient to transfer the plasmid/

siRNA into primary fibroblast cells relative to standard lipid transfection reagents (unpublished

work). Neon transfection is an electroporation-based transfectionmethod to transiently create pores

in the plasma membrane. The Neon transfection kit has different transfection buffers for adherent

and suspension cells. In this procedure, cells are suspended in a transfection buffer, electroporated

with the desired DNA, then transferred to cell culture plates or coverslips and grown for 24–48 h

before analysis.

10. Cells from step 6 are resuspended in 10 mL of solution R from the Neon transfection kit or home-

made buffer.3 Each coverslip will require 2–3 3 104 cells but a larger number of cells can be

transfected to plate several coverslips at the same time. We typically transfect 30 3 104 cells

at a time (in 10 mL).
4 STAR Protocols 5, 102915, March 15, 2024
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CRITICAL: Upon transfection, 5%–10% of cell death is often observed, depending on the
protein overexpressed or knocked down. It is important to have around 70% cell conflu-

ency while seeding the transfected cells on the coverslip. A low cell density will increase

cell death and impact cell growth and transfection efficiency, whereas high cell density af-

fects the quality of imaging.
11. Add 1 mg of the plasmid to transfect to the cell suspension (303 104 cells/10 mL). Gently tap the

tube to mix the plasmid with the cells.

CRITICAL: The concentration of plasmid DNA needs to be optimized. The concentration of
plasmid used for transfectionmight vary with the plasmid type and protein. 1 mg of plasmid

DNA is a good starting point, but the concentration can be either increased or decreased

depending on the cellular response and transfection efficiency. It is, however, challenging

to find transfected cells if a very low amount is used (<100 ng). On the other hand, higher

expression of the plasmid might result in off-target effects.
12. Place the Neon Tube into the Neon pipette station.
a

se

se

se
a. The golden electrode should touch the golden side ball plunger in the pipette station.

b. A click sound suggests the proper placement of the tube into the pipette station (refer to

Methods video S1 for the Neon transfection procedure).
13. Add 3 mL of electrolytic buffer E or homemade buffer3 to the Neon Tube.

Note: Store the remaining buffers (buffer E and buffer R) at 4�C after use.

14. Double-press the pipette to push out the clamp.
a. Insert the pipette clamp into the tip and push downward until there is a click sound.

b. Slowly release the pressure from the pipette button.

c. Make sure there is no gap between the tip and the pipette edge (refer to Methods video S1).
15. Press once the pipette and carefully aspirate the cell suspension containing plasmid DNA with

the help of Neon transfection 10 mL tip (refer to Methods video S1).

CRITICAL: Avoid bubbles while aspirating the samples. The presence of air bubbles gener-
ally causes a program error during transfection.
16. Set the program for the transfection in the Neon instrument program. For primary fibroblasts,

the following parameters work well without causing much cell death.
meter For primary fibroblast

voltage 1,400 V

width 20 ms

number 2
Note: Generally, transfection voltage, pulse width, and pulse time need to be optimized

based on the type of cells transfected.

17. Insert the pipette with the cell sample into the Neon tube until there is a click sound (refer to

Methods video S1).

18. Press ‘‘start’’ on the program to initiate the electroporation.

19. Once the electroporation is finished, the Neon instrument screen will display ‘‘complete’’ (refer

to Methods video S1).

20. Prepare 24-well plates with coverslips (Diameter: 12 mm; thickness: 0.13–0.16 mm).
STAR Protocols 5, 102915, March 15, 2024 5
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a. Collect transfected cells in the falcon tube containing the cell culture medium (500 mL/well of

24-well plate).

b. Transfected cells are seeded on the uncoated coverslips.

Note: While preparing multiple coverslips for each of the plasmids, cells can also be trans-

fected in bulk and grown for 16 h in a 12-well plate before seeding them in the 24-well plates

containing coverslips.

21. Repeat the transfection for other samples.

Note: Separate tips must be used for each cell type and plasmid DNA. Tips can be reused

following UV sterilization. Tips can be reused for transfecting other cell types by sterilizing

them in 70% ethanol followed by UV sterilization.3

Methods video S1: Video of transfection using Neon system.

22. Keep transfected cells 16 h in the incubator at 37�C with 5% CO2.

Note: If the cells are either stressed or exhibit cell death after 24 h, the medium can be re-

placed with fresh medium and left in the incubator for another 24 h.

23. 24–48 h post transfection,
6

a. Wash the coverslips with PBS once.

b. Fix cells by adding 500 mL of 4% paraformaldehyde (in PBS) for 10–15 min at 25�C.

CRITICAL: Paraformaldehyde should be warmed to 25�C before use as fixing with cold
PFA affects mitochondrial structure.4
24. Wash fixed cells once with PBS and store in PBS at 4�C. Coverslips can be stored for 6–12months

as long as they do not get dried out or cells detach.

Pause point:Coverslips can be stored at 4�C, and proximity ligation assay can be performed

later.
Proximity ligation assay

Timing: 7–8 h

Proximity ligation assay (PLA) measures the proximity of two proteins. In a PLA reaction, antibodies

are used to recognize each protein. Species-specific oligonucleotide-coupled secondary antibodies

(PLA probes) then bind to the primary antibodies. The oligonucleotides are then ligated together

when the two proteins are in close proximity (<40 nm) and this closed circular DNA is amplified

through a rolling circle mechanism. The amplified DNA is finally labeled by specific fluorescently

tagged oligonucleotides. This method can be used to detect the close proximity between two or-

ganelles by choosing surface proteins on the organelles of interest that functionally interact with

each other. For example, IP3R1 on the endoplasmic reticulum (ER) membrane interacts with

VDAC1 on the mitochondrial outer membrane, which can be used as a PLA pair (Figure 1).5 Alterna-

tively, abundant resident proteins homogenously distributed on the surface of the two organelles

can be used to detect the contact sites between the organelles.1 For example, TOMM20 on the

mitochondrial outer membrane and calnexin on the ER can be used to identify global changes in

mitochondria-ER contact sites (Figure 2). The PLA probes and amplification reagents can be bought

from Sigma-Aldrich as a Duolink kit.
STAR Protocols 5, 102915, March 15, 2024



Figure 1. Images of IP3R1 (endoplasmic reticulum)-VDAC1 (mitochondria) PLA foci in primary cells

PLA is influenced by the antibody pair chosen. Antibodies that non-specifically label organelle result in non-specific PLA foci as shown by the white

arrowheads. Boxed regions are enlarged in the bottom panels. Scale: 10 mm for actual image, 5 mm for the magnified image.
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CRITICAL: To perform PLA, it is important to choose two antibodies that specifically
recognize the cytosolic domain of proteins on the organelles of interest. These antibodies

must be validated and specifically label the organelle of interest without background/off-

target staining. Also, two antibodies must be from different animal sources.
Note: It is important to include negative controls where a coverslip will be labeled with a non-

specific IgG antibody from a similar animal source than one of the primary antibodies.

25. Permeabilize the fixed cells with 50 mL of permeabilization buffer (PBS containing 0.2% Triton

X-100) for 15 min at 25�C.

Note: Use 200 mL of permeabilization buffer (or enough to cover the coverslip) if permeabiliz-

ing directly in the 24-well plate.

Optional: Coverslips can be maintained in this homemade coverslip holder (Figure 3) where

coverslips are placed on top of Eppendorf tube lids that minimize the use of the reagents.

Using this setup, it is possible to use a volume as small as 30 mL for all antibody and PLA steps

since, as the edge of the coverslip does not touch anything, the liquid stays as a droplet on top

of the coverslip because of surface tension. If using a different system, such as a multi-well

plate, to incubate the coverslips or while utilizing large-sized coverslips compared to one

mentioned here (refer to key resources table) or when samples are mounted on the slides

directly, adjust volumes accordingly.

26. Wash the coverslips three times with PBS.

Note: Excess solution is removed from the coverslips by tilting them sideways on absorbent

paper with the cell side facing upwards.
STAR Protocols 5, 102915, March 15, 2024 7



Figure 2. Images of PLA foci in transfected cells

(A) Control PLA using IgG mouse antibody and TOMM20 (mitochondria). The PLA image demonstrates the specificity

of the assay.

(B) PLA for TOMM20 (mitochondria) and calnexin (endoplasmic reticulum). Boxed regions are enlarged in the bottom

panels. White arrowheads show non-specific foci. Scale bar: 10 mm for the actual image and 5 mm for zoomed images.

(C) Percentage of non-specific PLA foci (Calnexin-TOMM20, CLIMP63-TOMM20) in primary human fibroblast. Each

point represents an individual cell. Bars show the average G SD.
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27. Incubate the coverslips with a drop of Duolink blocking solution for 1 h at 37�C.

Note: Coverslips can be either maintained in a humidity chamber or a dry heating block in the

homemade coverslip holder (Figure 4).

28. Prepare 30 mL of primary antibodies per coverslip.
a. Dilute primary antibodies recognizing the organelles of interest (ER and mitochondrial pro-

tein here) in the antibody diluent provided with the PLA kit.

Note: Alternatively, a homemade blocking buffer can be used (refer to materials and equip-

ment section).

29. Remove the blocking solution.
8

a. Add the primary antibodies and.

b. incubate for 1 h at 25�C.

30. Remove the primary antibodies and.
a. wash twice the coverslips with 50 mL of wash buffer A for 5 min at 25�C.
STAR Protocols 5, 102915, March 15, 2024



Figure 3. Homemade coverslip support

Eppendorf tube lids are glued to the bottom of a 15 cm Petri dish. The dish and its lid are covered with aluminum foil to

protect coverslips from the light. To maintain the humidity and prevent the evaporation of the PLA solutions, wet

tissue is placed along the wall of the dish and a centrifuge tube cap filled with water is placed inside the dish.
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Note: The PLA kit includes a 1X wash buffer powder (A and B) sufficient to prepare 1 L in auto-

claved MilliQ or sterile water. Store at 4�C for long-term storage as specified by the manufac-

turer (https://www.sigmaaldrich.com/SE/en/technical-documents/protocol/protein-biology/

protein-and-nucleic-acid-interactions/duolink-fluorescence-user-manual). Prepare aliquots

and bring them to 25�C before use.

31. Prepare Plus and Minus probes in the antibody diluent at the ratio of 1:5. Une 30 mL probe so-

lution (plus and minus) for each coverslip.
Reagents Volume per coverslip, ml

Probe Plus 6

Probe Minus 6

Antibody diluent 18

Rea

5X

Ste
Note: To minimize the use of PLA kit components, we use a volume of 30 mL per coverslip for

probing, ligation, and amplification steps. Volumes will need to be adjusted if using a different

system.

CRITICAL: Prepare required volume of probes just before use. It is not advisable to store
the probe solution.
32. Add 30 mL probe solution and incubate coverslips at 37�C for 1 h.

33. Wash the coverslips twice with 50 mL wash buffer A for 5 min each at room temperature.

34. Prepare 1X ligation buffer by diluting at a ratio of 1: 5 in sterile MilliQ/ nuclease-free ultrapure

water.
gents Volume per coverslip, ml

ligation buffer 6

rile water 24

STAR Protocols 5, 102915, March 15, 2024 9
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Figure 4. Coverslips are maintained at the appropriate temperature in a homemade coverslip holder using a dry

heating block
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35. Prepare the ligation reaction mix just before addition to the coverslips. Maintain ligase at ‒20�C
in the freezer block.
Reagents Volume per coverslip, ml

1X ligation buffer 29.25

Ligase 0.75
CRITICAL: Prepare required volume of ligation solution just before use. It is not advisable
to store the ligation solution. Add ligase to the ligation solution just before use.
36. Remove the wash buffer and add 30 mL of ligation mix per coverslip.

37. Incubate the coverslips at 37�C for 30 min.

38. Wash the coverslips with 50 mL of wash buffer A twice for 5 min each at 25�C.
39. Prepare 1X amplification buffer in sterile ultrapure water.

CRITICAL: Buffer preparation and amplification steps must be performed in the dark.
Keep the diluted buffers protected from light.
Reagents Volume per coverslip, ml

5X Amplification buffer 6

Sterile water 24
CRITICAL: The amplification reaction mix must be prepared just before use, and the po-
lymerase must be maintained in a freezing block until diluted in the buffer.
Reagents Volume per coverslip, ml

1X Amplification buffer 29.625

Polymerase 0.375

10 STAR Protocols 5, 102915, March 15, 2024
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CRITICAL: Prepare the required volume of amplification solution just before use. It is not
advisable to store the prepared amplification solution. Add polymerase to the ligation so-

lution just before use.
40. Remove the wash buffer and add the amplification reaction mix.

41. Incubate the coverslips at 37�C for 1 h 40 min protected from light.

42. Wash the coverslips twice with 50 mL of 1X wash buffer B for 10 min each at 25�C.
43. Wash coverslips once with 50 mL of 0.01X wash buffer B for a minute.

Note: Use wash buffer B warmed to 25�C.

44. Prepare fluorophore-coupled secondary antibodies that recognize the primary antibodies that

were used for the PLA reaction.
a. Make sure that these antibodies have excitation and emission spectrums that are distinct

from the PLA signal.

b. Dilute the secondary antibodies (as mentioned in KRT) 1:500 in either homemade blocking

buffer or blocking solution supplied by company.

c. Add 50 mL of secondary antibody to the coverslips and incubate for 1 h at 25�C.

Note: For cells that can be stably transfected or transduced, an alternative to this step is

to use cells stably expressing ER or mitochondria-targeted fluorophores. For instance,

Huh7.5 cells stably expressing mito-mTurquoise2 have successfully been used for this

purpose.2

Note: There are always non-specific PLA foci, and labeling the organelles helps to identify the

genuine points of contact between the two organelles. (Refer to troubleshooting 1).

45. Tap off the excess of antibody mix and wash the coverslips with PBS three times at 25�C.
46. Dilute DAPI (1 mg/mL) in Duolink blocking solution or homemade blocking buffer.
a. Add 50 mL to each of the coverslips.

b. incubate for 10 min at 25�C.

47. Wash the coverslips with PBS three times at 25�C.
48. Add a drop of mounting solution on a microscopy slide and mount the coverslips on the drop

(with cells facing the solution).

Note: Avoid air bubbles while adding mounting solution and placing coverslips on the slides.

49. Acquire Images using standard confocal microscopy with a 63X oil-objective lens.

Note: Slides can be kept at 4�C for in the slide storage box up to 6 months, or until they

dry out.

Note: For flat cells like primary fibroblasts, single z-plane images covering the maximal cyto-

plasmic plane will be sufficient to identify all PLA foci. This can be achieved by either making

sure that mitochondria are properly focused or using the plane where the DAPI staining is the

strongest. However, when using cells that have a significant thickness, it is advisable to use

z-stacking to avoid missing foci from different focal planes.
EXPECTED OUTCOMES

When transfecting primary cells using this method, we typically get 30%–35% transfection efficiency.

For the PLA, the control IgG normally show no foci although some background foci can be observed

for some less specific antibodies (Figure 2). For a real PLA pair, we typically observe 50–300 PLA foci,
STAR Protocols 5, 102915, March 15, 2024 11
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depending on the PLA pair (Figures 1 and 2). PLA foci not localized to the target organelles should

remain below 10%.

QUANTIFICATION AND STATISTICAL ANALYSIS

PLA images can be either analyzedmanually or using the Analyze particle tool in Fiji Image J software

which can be downloaded for free here: https://imagej.net/software/fiji/downloads.

Note: Analysis can be done on individual cells or different regions of interest in a frame. Here,

we separated individual cells using polygonal tool in image J prior to the analysis.

Manual

Note: We generally use manual analysis when the number of PLA foci is below 100.

1. Open Images in Fiji Image J.

2. Merge the PLA channel with the ER and mitochondria channels (or any other organelles of

interest).

3. PLA foci colocalizing with ER and mitochondria are considered ‘‘true interactions’’.

4. PLA foci on neither of the organelles of interest are considered false positive foci.

Analysis using Image J

Note: There are multiple ways to count PLA foci by Image J. This method is useful when there

are more than 100 PLA foci.

5. Smooth the PLA channel using a median filter (value chosen based on the image noise level, nor-

mally 1 or 2).

Note: This step is used to remove noise in the image and smooth the contour of the PLA foci.

6. Convert the image into 8-bit grayscale (Image > Type > 8-bit).

7. Convert the 8-bit image into a binary image using the threshold function (Image > Adjust

> Threshold).
12
a. Use the default method.

b. Manually adjust the threshold value to represent the actual image.
8. Create a mask of the binary image, creating filled outlines of the PLA foci (Edit > Selection > Create

Mask).

9. Separate clustered foci using the watershed tool (Process > Binary > Watershed).

10. Use the Erode function to remove small foci that represent background signal. (Process

> Binary > Option > set iteration (10) and count (5) > Do: Erode).

11. Count particles using Analyze particles (Analyze > Analyze particles > default settings).

Note: Use the option Size (Pixel^2) to exclude any remaining small background particles.

12. Manually count Non-specific PLA foci that are negative for mitochondria and ER labeling. Re-

move these non-specific foci from the total particle count.

Statistical analysis

13. Count total true positive PLA foci per cell as above in control and test samples.

Note: It is ideal to count PLA foci in a minimum of 10–15 cells per experiment. At least 3 inde-

pendent experiments are required for statistical analysis.
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14. Depending on the number of test samples, compare PLA foci/cells in the test sample to the con-

trol by a two-way t-test or one-way ANOVA, Tukey post-hoc test (more than one test sample).

15. A p-value less than 0.05 is considered statistically significant with a 95% confidence interval.

LIMITATIONS

Primary human fibroblasts are excellent tools for studying cell biology. Their large size and the fact

that they are very flat cells make them ideal for microscopy studies. In addition, they do not contain

the genetic alterations present in malignant or immortalized cells. It is also possible to study specific

disease-causing mutations by using patient-derived primary fibroblasts. However, reviving,

culturing and handling primary cells is challenging and requires a lot of patience, especially for un-

trained hands. Primary fibroblasts also have a restricted maximal passage number (�20) and it is

preferable to use them at low passage numbers for investigations to avoid cellular aberrations

generally observed in ‘‘older’’ cells.

PLA is a straightforward method for measuring the proximity between two organelles that does not

require the use of electron microscopy. However, the antibody pairs used to detect contact sites

have a significant impact on the results. It is critical to identify protein combinations that preferen-

tially mark organelles without non-specific binding. It is also critical to keep in mind that this method

locates contact points between organelles based on the proteins’ proximity (40 nm, according to the

Sigma-Aldrich manual). Also, though any uniformly dispersed organelle surface proteins could be

chosen, it should be kept in mind that those contact sites are not necessarily related to any functional

role such as calcium or lipid signaling.

TROUBLESHOOTING

Problem

The presence of multiple non-specific PLA foci that are negative for either of the organelles (Step 45)

(Figure 1).
Potential solution

� Always include an antibody control where one of the protein-specific antibodies is replaced with Ig

control from similar species.

� Initially, perform pilot immunofluorescence studies to identify the best antibodies specifically la-

beling the organelles studied. It is better to avoid antibodies that show high background or off-

target staining.

� Table 1 shows the list of antibody pairs that we have tested to quantify ER-mitochondria contact

sites in different cells.
Table 1. List of antibody pairs that we have tested to quantify ER-mitochondria contact sites in different cells

Rabbit antibody Mouse antibody Use Reliability Cells tested

TOMM20 (Mitochondria, Abcam,
# ab186735, 1:250)

Calnexin (ER, Millipore,
# MABF2067, 1:200)

Mitochondria-general
ER interaction

Reliable Primary fibroblast,
Mouse embryonic
fibroblast,

IP3R1 (ER, Novus Biologicals,
# NBP2-22458, 1:200)

VDAC1 (Mitochondria,
Sigma-Aldrich, #MABN504, 1:200)

Mitochondria-general
ER interaction

Not fully reliable,
high non-specific
background staining

Primary fibroblast

IP3R1 (ER, Novus Biologicals,
# NBP2-22458, 1:200)

VDAC1 (Mitochondria,
Abcam, # ab14734, 1:100)

Mitochondria-general
ER interaction

Partially reliable Hepatocarcinoma
Huh7-derived cells

PTPIP51 (Mitochondria, Sigma-Aldrich,
# HPA009975, 1:100)

VAPB (ER; Proteintech
# 66191-1-Ig, 1:100)

Mitochondria-general
ER interaction

Reliable Hepatocarcinoma
Huh7-derived cells

TOM20 (Mitochondria, Abcam,
# ab186735,1:250)

CLIMP63(ER, ENZO,
# ENZ ABS669, 1:200)

Mitochondria- rough
ER interaction

Reliable Primary fibroblast

SYNJ2BP (Mitochondria, Sigma-Aldrich,
# HPA000866, 1:200)

RRBP1(ER, Thermo Fisher Scientific,
# MA5-18302, 1:200)

Mitochondria- rough
ER interaction

Reliable Primary fibroblast,
Hepatocarcinoma
Huh7-derived cells
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RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Marc Germain (marc.germain1@uqtr.ca).

Technical contact

Further information on technical aspects should be directed to Marc Germain (marc.germain1@uqtr.ca).

Materials availability

This study did not generate new unique reagents.

Data and code availability

This study did not generate new datasets.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2024.102915.
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